Fiskalizacija - Check list

RITAM FORMS

OSNOVNA PODESAVANJA CENTRALNOG SUSTAVA

Napomena! U prilogu se nalaze dodatne upute za:
a) Preuzimanje i pohrana verifikacijskog RDC CA root certifikata (str. 2)
b) Preuzimanje | pohrana aplikativnog certifikata za fiskalizaciju (str.10)

c) Export certifikata (str.15)

v" Podaci poduzeca: Postaviti datum pocetka fiskalizacije (kartica , Fiskalizacija“)

v' Podaci poduzeéa: Pohrana verifikacijskog/root i aplikativnog certifikata u bazu podataka u svrhu
lakse distribucije na lokacije (NIJE OBAVEZNO)

v' Radne jedince (Katalozi/Pode$avanje sustava/Radne jedinice/Lista radnih jedinica) — popuniti u
polje ,,Radno vrijeme” za one na kojima se dogada gotovinska prodaja

v' Korisnici (Katalozi/Pode3avanje sustava/Korisnici/Korisnici) — popuniti polja ,0IB“, ,IME“,
,PREZIME" za korisnike

Polja ,IME” i ,PREZIME” — mora biti popunjeno jedno od polja ili oba. Zakonodavac je propisao
obvezu prikaza oznake blagajnika na racunu

PODESAVANJE RITAM FORMS KLIJENTA (NAPLATNI UREDA))

v Instalacija verifikacijskog/root (ukoliko ste ga pohranili u bazu podatka moZete ga instalirati iz
kataloga ,,Podaci poduzeca“ — kartica , Fiskalizacija“ )

v Instalacija aplikativnog certifikata (ukoliko ste ga pohranili u bazu podatka moZete ga instalirati iz |:|
kataloga ,Podaci poduzeca“ — kartica ,Fiskalizacija” )

v lzgled raduna — (Pomo¢ni alati/Robni/Postavke prodajnog mjesta (POS)) - ukljuéiti prikaz vremena [
na racunu (Ispis datuma na racunu —,,Datum i vrijeme”), vrste plac¢anja, blagajnika

v' Provjera minimalnih tehnickih uvjeta — (Pomoéni alati/Robni/Postavke prodajnog mjesta (POS))
kartica ,Fiskalizacija“. Ukoliko nakon izvrSavanja akcije ,Provjera tehnickih uvjeta” nisu ispunjeni
isti, potrebo je instalirati .NET framework 2.0 (ili noviji) zbog potrebe rada fiskalnog modula. |:|
Preuzimanje i instaliranje .NET framework 2.0 Vam je dostupno u sekciji ,,Dodaci za rad fiskalnog
modula“

v' Provjera veze sa poreznom upravom — (Pomoéni alati/Robni/Postavke prodajnog mjesta (POS))
kartica , Fiskalizacija” — (biti ¢e u funkciji od 27.12.2012.g. kada bude dostupan server Porezne |:|
uprave)
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Preuzimanje i pohrana verifikacijskog RDC CA root certifikata

Da bi se rijeSio problem kojim Internet Explorer i Mozilla Firefox upozoravaju na moguci sigurnosni

problem prilikom pristupa stranici https://mojcert.fina.hr/finacms/, potrebno je prvo preuzeti RDC

CA root certifikat te ga zatim pohraniti unutar Windows Certificate Store-a.

1. Preuzimanje RDC CA root certifikata

Ovaj se certifikat moZe preuzeti sa stranice http://rdc.fina.hr na sljedeéi nacin:

Internet Explorer:

IgJ http://rde.fina.hr/

fiew Favorites Tools Help

it~ [P Select
| £ Entrust Authority™ Enrolim. ..

htar za Reqgistre Digitalnih Certifikata (RDC)

£ FINARA %

I

AladdinEtokenPro —OpenSC &  Suagested Sites v @ | Free Hotmail € | Web Slice Gallery »

e Zakon o elektronickoj trgovini

e \Vernkaclsk

e Preuzimanje digitalnog certifikata

(SHA1: 4c:4b\d:f2:a8:d7:64:c1-fe:dc:81:afd6:3

rtifit

t (samopotpisani) cent

! RDC CA root certifikat | Preuzimanje certifikata | PretraZivanje javnog imenika

» RDC CA root certifikat & preuzimanje digitalnih certifikata

at za RDC CA

7:0f50:30:7a:0a:12)

e Preuzimanje digitalnog certifikata za Web posluZitel]
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Potrebno je pohraniti certifikat na disk racunala:

File Download - Security Warning 7 ﬂ

Do you want to open or save this file?

Name: RDCca.cer
— Type: Security Certificate, 1,07KB

From: rdc.fina.hr

Gpen | S

potentially harm your computer. |f you do not trust the source, do not

@ While files from the Internet can be useful, this file type can
- open or save this software. What's the risk?

Definiranje lokacije pohrane:

21x]
Savein: | () web - O y.

My Recent
Documents

-
"
@
2

Desktop

4

My Documents

-
%
My Compuiter

-

Save

My Network File name: IRDCca.cer

Places

Lef Lo

Save as type: ISecwity Certificate Cancel
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Mozilla Firefox:

Na Firefox pregledniku potrebno je preuzimanje izvrsiti na ovaj nacin:

(SHA1: 4c:4bed:f2:a8:d7:64:c1:{  ©OpenLinkin New Jab - 1
e Preuzimanje digitalnog certifikata _ OPen Linkin New Window
¢ Preuzimanje digitalnog certifikata g oo This Link

» Pretrazivanje javnog imenika Copy Link Locath

Poslovni: | (  Inspect Element (Q) pfe koristifi *, ny

N

)

Definiranje lokacije pohrane:

24
Savein: | ) web = O _7.

My Documents

-
o
My Computer
-
My Network File name: IRDCca.cet
Places

Save

Cancel

L Lol

Save as type: |Secwily Certificate
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2. Instalacija RDC CA root certifikata

Instalacija RDC CA root certifikat moze se obaviti na nekoliko nacina ali najbolji je preko mmc konzole.

Potrebno je preko tipke Start ->Run (Windows XP) ili Search programs and files (Windows 7) upisati mmc.exe te zatim

odabrati “OK”:

- Type the name of a program, folder, document, or
% Internet resource, and Windows will open it for you,

Open: El

O_Kt Cancel I Browse... |

istot| € @@ (I IBEE | el

Pojavljuje se mmc konzola na kojoj je potrebno odabrati , File->Add/Remove Snap-in...”

_

File Action View Favorites ‘Window Help

New Ctri+N

Open.., Ctrl+0

o e
Add/Remaove Snap-in.. Ctrl+m

Options. .. k

1 CAWINDOWS\system32\dfrg.msc

2 CAWINDOWS), . \inetsrvliis.msc
3 CAWINDOWS).. . \compmgmt.msc
4 C:IWINDOWS!,. . \devmagmt.msc

Exit
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Sada je potrebno na sljede¢em ekranu dodati snap-in Certificates:

Odabrati Computer account:

Certificates snap-in

Add Standalone Snap-in

NET Framework 1.1 Configuration
Active Directory Domains and Trusts

W3 Active Directory Schema

i Active Directory Skes and Services
Active Directory Users and Compu...
ActiveX Control

& authorization Manager
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Odabrati Local computer:

Select Computer | x|

Select the computer you want this snap-in to manage.

~ This snap-in will always manage:
(¢ Local computer: [the computer this console is running on)

" Another computer. |

[T Allow the selected computer to be changed when launching from the command line. This
only applies if you save the console.,

< Back Fir{<h Cancel

Nakon toga predstoji import RDC CA root certifikata:

—
iti Console Root

] Console Root
=P Certificates (Local Computer)
[ Personal
R | Trusted Root Certificatic
= l:;] Enterprise Trust
#) -] Intermediate Certificatio
-] Trusted Publishers
*
[

@Certiﬁcates (Local Computer)

Find Certificates. .. |

Find Certificates. ..

1- (L] Untrusted Certificates New Window from Here
+-(_] Third-Party Root Certific
#)-(_] Trusted People Refresh
-] Address Book Help
] (] Other People
(1 sPC

Sljededi ekran:
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Certificate Import Wizard

x|

Welcome to the Certificate Import
Wizard

This wizard helps you copy certificates, certificate trust
lists, and certificate revocation lists from your disk to a
certificate store,

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept,

To continue, chick Next,

< Back Next Cancel ]

Odabir datoteke s certifikatom:

File to Import
Specify the fila you want to import,

Fie name:

Fies of type:

lROCca.cer _'__l | Open I
=

]X 508 Certificate (".cer".cit) Cancel

/7
ha
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Odabir mjesta pohrane certifikata:

Certificate Import Wizard

Ovim je zavrsena instalacija RDC CA root certifikata.
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Preuzimanje i pohrana aplikativnog certifikata za fiskalizaciju

1. Preuzimanje aplikativnog certifikata za fiskalizaciju u Windows okruzenju - Internet Explorer

Internet adresa portala za preuzimanje certifikata za fiskalizaciju je https://mojcert.fina.hr/finacms/

Nakon Sto se otvori stranica za preuzimanje certifikata, potrebno je odabrati tipku ,,Registriraj se”, te zatim ,Preuzimanje
soft certifikata”:

Registracija
PIN registradija Preuzimanje Soft certifikata Registradja - OTP

Molimo unesite referentni broj i autorizacijski kod

Referentni broj:
FFAA6CCB085E4CS5F017F

Autorizaciski kod:

000004

7 Regis{'pi(jaj se X Zatvori

10/21


https://mojcert.fina.hr/finacms/

Fiskalizacija - Check list

Nakon upisivanja ispravnih autorizacijskih podataka, CMS otvara ekran s raspolozivim certifikatom za preuzimanje:

[] certifikati Kiju&evi Zahtjev Izdavanje Pohrana Status
cn=FISKAL 1,I=ZAGREB,0=TEST D.D. HR32343... b 4 b4 x x Spreman

gjudqo*;émm

Oznacdite certifikat za preuzimanje i odaberite ,1zdaj oznacene” .

Ovime zapocinje preuzimanje certifikata za fiskalizaciju, te se prikazuje ekran za unos lozinke koja ce stititi ovaj certifikat:

' Lozinka za P12 datoteku

Molimo Vas da unesete lozinku za p12 datoteku.

Lozinka je potrebnu za uspjesno koriStenje p12 datoteke sa
certifikatima.

Lozinka mora sadrZavati barem jedno veliko slovo (A do Z), malo
slovo (3 do z) i brojku (0 do 9).
Zahtjevana minimalna dufina lozinke je 6 znakova.

Lozinka: 12343A

Lozinka zapisana. . ©u @ou | €3 Odustani

-

Nakon sto se lozinka upiSe na ekranu, potrebno je oznaditi prozorci¢ da je lozinka zapisana te se onda omogucava odabir
tipke ,,U redu”.
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Proces preuzimanja se nastavlja.

5§ 8 2
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Fiskalizacija - Check list

2. Pohrana u Win XPi IE:

File Download [ X | I

Do you want to open or save this file?

o

@ Name: FISKAL 1.P12
- Type: Personal Information Exchange

From: demo-mojcert.fina.hr

DOpen | Sa!;% | Cancel I

a‘ While files from the Intermet can be useful, some files can potentially

harm your computer. If you do not trust the source, do not open or .

|
4 savethisfie What's the isk?

Nakon toga je potrebno odrediti mapu pohrane:

Save As

Save'n:lbweb El O ¥ L [

0% of softTokenlssuing from demo-moijcert.fina.hr Completed sl B3 |

k4 B3

b [E3F1sKaL 1.P12

My Recent
Documents

Desktop

4

My Documents

o

My Computer

=

-

PR File name: [FISKAL 1.P12 ~| Sav
Places
Save as type: |Persona| Information Exchange ZI Cance
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Pojavljuje se ekran sa opcijama koje je moguce pokrenuti:

Download complete M =] B3

/8

— Download Complete

FISKAL%201.P12 from demo-mojcert.fina.hr

Downloaded: 2,87KB in 1 sec
Download to: D:\instalacije\web{FISKAL 1.P12
Transfer rate: 2,87KB/Sec

[ Close this dialog box when download completes

Open Opf§-Folder Close
> ;| SmartScreen Filter checked this download and did not report any
v—  threats. Report an unsafe download,

3. Pohrana u Win 7
Internet Explorer:

Ako se certifikat preuzimao kroz Windows 7 u Internet Exploreru, pojavljuje se u dnu ekrana opcija ,Save” koja vrsi
pohranu certifikata.

Copyright ® 2009-2 Do you want to open or save FISKAL 1.P12 from demo-mojcert.fina.hr?

ZavrSetak postupka pohrane kroz Internet Explorer:

The FISKAL 11.P12 download has completed. Open ». Open folder View downloads
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Mozilla Firefox:

Ako se certifikat preuzimao kroz Windows 7 u Mozilla Firefoxu pojavljuje se slijedeci ekran:

Odabrali ste pokrenuti

|25 FISKAL 1.P12
koja je: P12 File
iz: https://demo-mojcert.fina.hr

Sto bi Firefox trebao uéiniti s ovom datotekom?

| Od sada ucini to automatski za datoteke poput ove.

Otvaranje mape u Firefoxu:

vesna.jpg Otvori sadrzajnu mapu

S 701 KB —c¢ Idi na stranicu preuzimanja

g Kopiraj poveznicu preuzimanja(l)

4,0 KB —fi Oznacdi sve

fotografi Ukloni s popisa
-~

154 KB — googleusercontent.com

Ovim je zavrSena instalacija aplikacijskog certifikata
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Eksport certifikata

Sljedeci korak je eksport certifikata, a radi se na sljedeci nacin:
Iz izbornika Internet Explorera Tools->Internet Options->Content->Certificates->Personal treba pronadi certifikat za
fiskalizaciju te odabrati tipku Export:

Certificates L ._9_‘5

Intended purpose: I<AII> 3

Personal |0ther People l Intermediate Certification Authorities | Trusted Root Certificatior_4 I » |

Friendly Name
<None>

Issued To
=2 FISKAL 1

Test 07.09.2014

Import. .. I Export[\: | Remove Advanced...l

N

Nakon sto pritisnete tipku «Export» pojavit ¢e se sljededi ekran:

Certificate Export Wizard @

Welcome to the Certificate Export

Wizard

This wizard helps you copy certificates, certificate trust
lists and certificate revocation lists from a certificate
store to your disk,

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept,

To continue, click Next.

E__[‘l_-ext> j [ Cancel ]
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Odaberite tipku «Next» i pojavit ¢e se sljededi dijalog:

Certificate Export Wizard @

Export Private Key
You can choose to export the private key with the certificate.

Private keys are password protected. If you want to export the private key with the
certificate, you must type a password on a later page.

Do you want to export the private key with the certificate?

(®)¥es, export the private keyi
(O Mo, do not export the private key

[ < Back ][_Next > ] [ Cancel ]

Odaberite opciju «Yes, export the private key» i pritisnite tipku «Next»

Certificate Export Wizard @

Export File Format
Certificates can be exported in a variety of file formats.

Select the Format you want to use:

de all certificates in the certification path if possibl

(3) Personal Information Exchange - PKCS #12 (PFX):
[ 1nclude all certificates in the certification path if possible

Enable strong protection (requires IE 5.0, NT 4.0 SP4 or above)
[ Delete the private key if the export is successful

[ < Back ]uexl» ] [ Cancel J
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Odaberite tipku «Next».

Certificate Export Wizard

Password
To maintain security, you must protect the private key by using a password,

Type and confirm a password,

Password:
[******

Confirm password:

|nm*xmm|

[ < Back ][ Next > ] [ Cancel ]

Upisite Sifru (password) kojom Stitite privatni klju¢ certifikata za enkripciju i odaberite tipku «Next». Ovu Sifru je
potrebno pohraniti na sigurno i ¢uvano mjesto kako ne bi doslo do zlouporabe privatnog kljuca.

Certificate Export Wizard @

File to Export
Specify the name of the file you want to export

File name:

[ < Back ][ MNext > ][ Cancel ]

Ovdje odaberite tipku «Browse...» da odaberete lokaciju na koju ¢ete smjestiti certifikat.
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Nakon odabira lokacije pohrane p12 datoteke pojavljuje se ekran:

20
Save in: l@ Desktop :l (€ 5 A

My Ret':ent

Documents

My Documents
'j My Computer

2.)Google Talk Received Files
1) Shortcut to Administrator's Documents
) Shortcut to Desktop

My Computer =
& v Shortcut to My Data Sources

-
b

TS File name: ffiskal 1| 2 Savg, |
Places I

Saveastype:  |Personal Information Exchange (*.pfs) >l Cancel

Upisite ime pod kojim Zelite nazvati certifikat i tipku «Save».

Certificate Export Wizard 3 _X_l

File to Export
Specify the name of the file you want to export

File name:
l C:\Documents and Settingsizspoljaric\Desktopifiskal 1.pfx Browse...

< Back I Newt>[§J Cancel |

Pritisnite tipku «Next».
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Sljede¢im ekranom zavrsava export enkripcijskog certifikata:

Certificate Export Wizard @

Completing the Certificate Export
Wizard

You have successfully completed the Certificate Export
wizard.

You have specified the Following settings:

File Name C:\Doc
Export Keys Yes
Include all certificates in the certification path No

File Format Person
£ >

[ < Back ][ Finish J [ Cancel ]

Pritisnite tipku «Finish» i pojavit ¢e se dijalog koji vas obavjestava o pokusaju aplikacije da pristupi zasticenoj datoteci
(privatnom kljucu):

Exporting your private exchange key

An application is requesting access to a Protected item.

CryptadPl Private Key

DK [ Cancel J[ Details... J
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Zavrsetak eksporta certifikata:

Certificate Export Wizard @

The export was successful,
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